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1 Accessing the HARP Member Portal 

 
The HARP (HRA Assessment Review Portal) Members’ Portal is a web-based 
management information system used by the HRA to enable the online electronic 
review of research ethics applications and amendments.  
 
The Portal can be accessed at: https://www.harp.org.uk/Portal/Account/Login 
 
The system is optimised for Internet Explorer (IE) 10 and Firefox; however, it will also 
work on other web browsers. 
 
To access the Portal, enter your username and password into the relevant fields and 
click on the Login button. If you do not have a HARP account or have any questions 
regarding HARP, please contact the member of staff supporting your REC or the 
HARP helpdesk in the first instance: helpdesk@harp.org.uk  

Figure 1 – The HARP Member Portal Login Screen  
 

 

https://www.harp.org.uk/Portal/Account/Login
mailto:helpdesk@harp.org.uk


2 HARP Member Portal Terms & Conditions 

On login, you will be presented with the Terms & Conditions of use for the member 
portal. You will need to tick the box to state that you accept the Terms & Conditions, 
in order to proceed to use the member portal. If you do not wish to accept the Terms 
& Conditions or have any questions, please contact your Approvals Officer in the first 
instance.  

Figure 2 – The Terms & Conditions Screen 

 
 

3 The User Account Area 

To access your account details, select your name at the far right of the Main Menu 
and then select ‘profile’. You are then able to view, edit and save your account 
details. You can change your password by ticking the Change Password check box 
and then entering the new password in the fields that appear. You can also view a 
copy of the Terms and Conditions from here once you have accepted them.  

Figure 3 – The User Profile 
 

 

 



4 The Calendar View 

The Calendar view appears as soon as you login. It displays every meeting that you 
are assigned to as a committee member. Using the meeting calendar is the easiest 
way of accessing meeting documents which have been assigned to you.  There are 
4 meeting types that can be displayed, and each meeting type is identified by a 
coloured calendar entry as shown below.  

Please note, the calendar view will only show meetings which you have been 
assigned to attend.  

 

Figure 4 – The Calendar View 

 

 

 

5 The Meeting View 

Clicking on the Meetings button in the purple bar at the top of the screen presents 
you with a list of all the meetings which have been set up for the REC. Clicking on 
any of the meetings will allow you to view applications or documents which have 
been added to the meeting. 

You can view different months by 
using the arrows in the top right of 
the screen. 

To view a meeting and all of the associated 
documentation, click on the meeting’s 
calendar entry.  

 



Figure 5 – The Meeting View 

 

 

6 Viewing a Meeting 

When you have selected a meeting from either the Calendar or Meetings tab you will 
see the following three tabs associated with the meeting: Details, Documents, and 
Applications/Amendments. 

The Details Tab displays the meeting’s details: the meeting reference, the location of 
the meeting and any notes that have been added by the Approvals Officer.  

 

Figure 6 – The Details Tab 

 

 

The Documents Tab displays all of the documents (those not associated with an 
individual application) uploaded against a meeting in HARP and marked as available 
for review e.g. the Meeting Agenda, Minutes for checking and REC  Report. Click on 
the file name to view and download the document. You can add comments by 
clicking in the blue comments box.  



 

Figure 7 – The Documents Tab 

 

The Applications/Amendments page is where you can access the applications or 
amendments which have been assigned to the meeting, open the application 
documents and download them to your device.   

To view the details and the documentation associated with one of the applications or 
amendments, click on either the short title or REC reference number.  

 

Figure 8 – The Applications/Amendments Tab 

 

 

 



7 Viewing an Application or Amendment 

Clicking on the title or reference number for an application or amendment directs you 
to the application itself, where you will find the ‘References’, ‘Documents’, ‘Meetings’, 
and ‘Ethical Review Form’ tabs as shown in Figures 9 - 13. 

The reference tab displays basic details regarding the application, such as the study 
type, REC Reference and IRAS Project ID. 

 

Figure 9 – The References Tab 

 

 

 

The documents tab shows the submitted documents associated with the application 
or amendment. 

To save a document click on the document which you would like to open, open the 
file and click ‘Save as’. This will save a copy to your personal computer or other 
device. 



Figure 10 – The Documents Tab 

 

 

If you would like to download and save all the documents, you can click the blue 
‘download documents’ button. This allows you to save a copy of the 
applications/amendments and read them later. A zip-file will open in a separate 
window, which you can save to your device. The documents within the zip-file will 
always be in a specific order: Cover Letter; IRAS Form; Protocol; Chief Investigator 
CV, All Participant-facing Documents; All Other Documents. 

You can also download a bespoke selection of documents by unchecking any 
documents you do not wish to download in the download document column. 

 

Figure 11 – How to Download Documents 

 

 

 



Figure 12 – The Documents Zip File 

 

 

 

The meetings tab shows which meeting/s the application or amendment has been 
assigned to.  

 

Figure 13 – The Meetings Tab 

 

8 Conducting your Ethical Review 

When conducting your review, the simplest way to record any comments or 
questions is via the Ethics Review Form, which is on the right-most tab in the 
application. 



The form contains the ten ethical domains that the review is usually broken down 
into. You can view prompts on what to look for in each domain (and where to look for 
it) by hovering your cursor over the ‘Info’ button by each domain. 

 

Figure 14 – The Ethics Review Form 

 

To leave a comment, click on the speech bubble icon by each domain. A 
‘Comments’ box will open. Click on ‘Add Comment’, leave your comment in the free 
text box, then click ‘Save’. Your comment can then be viewed by the other members 
of the Committee, and by your Approvals Officer.  

If you wish, you can click the ‘Private comment’ box before clicking save. If you do 
so, only you will be able to see your comment. 

Once you have saved your comment, click on the ‘x’ in the top right corner of the 
comment box to close it.  

 

Figure 15 – Adding a Comment 

 

 



Once you have added and saved your comment, you will see that the speech bubble 
by the ethical domain has turned from blue to red. 

If the speech bubble icon is red this means that a comment has been entered either 
by yourself or by a different member of the Committee Members can read each 
other’s comments by pressing on the speech bubble icon again to re-open the 
comments box. 

Before the meeting, you can save a copy of the completed ethics review form to your 
desktop. Clicking on the ‘Download Form’ button will create a Word document, 
containing the comments made by all members. 

 

Figure 16 – Downloading the Form 

 

 

Figure 17 – Ethics Review Form Word Document 

 



For Amendments, there is no ethical review form. Instead, you can add comments to 
each document by selecting the ‘Comments’ button. When you click the button a pop 
up appears (Figure 17). Once a comment has been added to a document, the 
‘Comment’ button changes from blue to red. You can also view any other comments 
which have been added by other members or by the Approvals Officer. These 
comments can only be viewed when you are online.  

To add a comment, type into the text box labelled ‘Type your message here…’ and 
click ‘save’. This comment will be visible to all members of the REC.  

Other REC Members and the Approvals Officer will be able to see your comment. 
Clicking the ‘private comment’ box means that the comment will not be viewable to 
other.  

 

Figure 18 – Leaving comments on an Amendment 

 

 

At the bottom of the page in each amendment, there is an ‘Overall Comments ‘ box (Figure 
18).  Comments entered here can be seen by other members using the portal. You can also 
choose whether to make the comment viewable to the Approvals Officer via the ‘Visible to 
REC Manager’ box.  
 

 

 

 



Figure 19 – The Overall Comments box 

 

 
 

Figure 20 – Overall Comments added and visible 

 

 
 
  
You can, if you wish, add comments directly to the application documents. These will not 
save to the HARP portal. Please see Appendix A – Annotating Documents for instructions on 
how to do this. 
 

9 Help 

Clicking on the Help icon (on the blue ribbon at the top of the screen) allows you to 
access a copy of this User Manual and the accompanying Frequently Asked Questions 
document.  

 

 



Figure 21 – The Help Icon 

 

 

 

A user instruction video, which talks you through all of the steps outlined in this manual, is 
available at the following link: 
 

• https://www.hra.nhs.uk/about-us/committees-and-services/harp/ 

 

10 Appendix A – Annotating Documents 

Comments can be added in relation to specific documents in the member portal as 
described in section 8 above. You may find this particularly useful for Proportionate 
Review applications and substantial amendments which are reviewed in 
correspondence. However, for full REC meetings in which you may not have access 
to an internet connection you may find it more useful to download the documents 
and insert comments and highlight information directly into the document; and view 
as a saved document at the REC meeting.  

This appendix provides information regarding how to add comments and highlight 
sections on electronic copies of application documents.  

Adding Comments – PDF Documents 
 

There are two ways of adding comments to a PDF document: 

• You can right click on the mouse and click ‘add sticky note’  

 

• You can click the ‘Add sticky note’ button in the ribbon at the top of the 

document 

The document including your comments can then be saved to your device to refer to 
during the meeting.  

https://www.hra.nhs.uk/about-us/committees-and-services/harp/


 

Figure 22 – How to add a comment to a PDF Document 

 

 

Adding Comments – Microsoft Word Documents 
 

Go to the Review tab and use the ‘New Comment’ button to insert a comment. The 
comment will appear in the margin as shown in the example below.  



Figure 23 – How to add a comment to a Word Document 

 

 

Other similar software, such as Libre Office open-source software, will have their 
own equivalent to the Microsoft Word method. Please consult your software’s ‘HELP’ 
guides to learn the method for your software. 

 

Highlighting Documents – PDF Documents 
 

Use the highlighting tool, found in the top ribbon, to highlight sections of the 
application or supporting documents which you may wish to discuss during the 
meeting.  

You can also highlight text by selecting the wording which you wish to highlight, right 
clicking the mouse and clicking ‘Highlight text’ 

 

 

 

 

 



Figure 24 – Highlighting a PDF Document using the ribbon 
command 

 

 

 

Figure 25 – Highlighting a PDF Document by right-clicking the 
mouse 

 

 

 

 



Highlighting Documents – Microsoft Word Documents 
 

From the Home tab, click on the highlighter pen to highlight sections of the 
document. You can then right-click and drag your cursor across the sections of text 
you wish to highlight 

 

Figure 26 – Highlighting a Word Document 

 

 

Searching Documents for Key Words 
 

You may find it useful to search documents for key words. Most document types 
support the same method for doing this. Press the Ctrl key and the F key at the 
same time. A small navigation box will appear. Enter the word or phrase you wish to 
search for. Click the Enter/Return key.  

The search will instantly find the first occurrence of that word/phrase in your 
document. If you click Enter/Return again, it will find the next occurrence. You can 
continue clicking Enter/Return to find every occurrence of the word/phrase in the 
document. 

 

 

 



Figure 27 – Searching a document for key words 

 

 

Please remember to refer to the Frequently Asked Questions Document and the 
HARP Member Portal Instruction Video to refresh/reinforce your learning. 


